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Copyright

This manual and the program It describes are
protected by the copyright laws and therefore may not
be reproduced (except to make a backup copy), in
whole or in part, whether for sale or not, without
written consent from Ad Lib Inc. Under the copyright
laws, copying includes translation Into another
language or format.

The purchaser may use the program on any computer
In his or her posesslon, but on only one computer at a
time. It Is possible, however, to purchase a multi-user
licence authorizing the purchaser to use the program
on several computers in his or her posesslon.
Including a shared disk system.

Ad Lib Personal Computer Music System, Ad Lib
Music Synthesizer Card, Ad Lib Juke Box, Ad Ub
Instrument Maker and Ad Lib Visual Composer are
trademarks of Ad Lib Inc.
IBM PC, XT, AT, Color/Graphics Adapter and
Enhanced Graphics Adapter are registered
trademarks of International Business Machines

Corporation.
PC/MS-DOS 2.00 and Microsoft are registered
trademarks of Microsoft Corporation.
Roland and MPU-401 are trademarks of Roland DG

Corp.
Mouse Systems Is a trademark of Mouse Systems
Corporation.

Technical Support

Ad Ub Inc. Is firmly committed to providing the highest
level of customer service and product support. If you
experience any difficulties when using our product, or
If It falls to operate as described, we suggest you first
consult the User Guide, and then, if you are still In
need of assistance, contact your dealer or call our
Technical Support Department:
Tel.: (418) 529-6252.

Notice

Ad Ub Inc. reserves the right to make changes or
improvements In the product described In this manual
at any time and without notice.

Limited Warranty

Ad Lib Inc. warrants the products that It manufactures
to be free of any defects In materials and
workmanship for a period of ninety (90) days from the
date of purchase. This warranty is limited to the
original purchaser of the product and Is not
transferable.

Ad Lib Inc. will refund, repair or replace, at Its option,
any media or documentation at no additional charge. If
found defective. The purchaser is responsible for
returning the product, and must provide a dated proof-
of-purchase. Each program Is sold "as Is", and Ad Ub
Inc. will not be held responsible In any way
whatsoever for direct or Indirect damages of any
nature resulting from the use of the program.

The purchaser has, however, the right to the legal
warranty when and to the extent that It Is applicable,
notwithstanding any limitation or exclusion.
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Introduction

Visual Composer Is Intended for anyone Interested In creating
their own music. There Is no need to know traditional musical
notation, or even how to play an Instrument. With Visual
Composer, you write music as If you were drawing It!

In addition to this guide, which Instructs you on how to use the
program, you will find an Instruction booklet showing you the
basics of composing music In many different styles and
Including a glossary of musical terms.

The first section of this guide, entitled "Getting Started", tells
you everything you should know before using the program.

The second section, "Using Visual Composer", shows you how
to use the program Itself. You will learn how to write music,
how to manage files, what to do to listen to a piece, and finally,
how to print your pieces.

The third section gives you a step-by-step example which
covers the essentials of the program.

The fourth section, "References", offers a summarized
description of all the commands.

In the appendices, you will find a list of preset sounds provided
with Visual Composer, a list of possible error messages,
technical data, and Information pertinent to using a MIDI
Interface and a mouse.

Visual Composer Is Ideal for music lovers. Write your own
music, put It Into the Juke Box playback program provided with
the Ad Lib Synthesizer Card, and Invite your friends over for a
party!
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/m^ Getting Started

Required Equipment

^  This section lists the equipment required to run this program
and explains the contents of the diskette. It also shows you
how to make startup diskettes, how to install the program onto
a hard disk, and explains the way to load the program.

^  Required Equipment

^  To run Visual Composer, you need the following:
The Ad Lib Music Synthesizer Card.

^  2. A computer:
IBM-PC, PC XT, PC AT or a compatible equipped with at
least a 360K disk drive and 256K of memory (additional
memory enables longer or more complex pieces).

^  3. A graphic display card:
^  "IBM Color Graphics Adapter" (CGA) or "IBM Enhanced
^  Graphics Adapter" (EGA).

4. An operating system:
PC/MS-DOS 2.00 or all latest versions.

5. Headphones, external loudspeaker or stereo system.

NOTE: You can also use Visual Composer with a mouse and with a
^  MIDI interface. Consult the appendices for details.
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Contents of the Diskette
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Contents of the Diskette

The Visual Composer diskette contains several files related to
the program:

•  AUTOEXEC.BAT ^
This file automatically loads Visual Composer from the -
moment your computer is turned on.

{mm

•  COMPOSER.BAT «

This file contains the command sequence which loads
Visual Composer from the DOS. ^

•  C0MP0S1.EXE

This file contains the main part of Visual Composer.
Do not directly load this file. Instead, use the file
COMPOSER.BAT which contains the normal loading ^
sequence. *

10

C0MP0S1.RSR
This file contains the resources required by Visual
Composer.

SOUND.COM

This file contains the sound driver for the Ad lib
Synthesizer Card.

{mm

VCINSTALBAT ^

This file contains the DOS command sequence ^
necessary to prepare your Visual Composer program ^
diskettes.

mm

mm



Getting Started

Contents of the Diskette

•  MPU401.COM

This file contains the driver for the ROLAND MPU-401
MIDI interface.

•  VCPRINT.EXE

This file contains the Visual Composer print utility
program.

•  MNS

The ".INS" files contain the instrument sounds.

•  *.ROL

The ".ROL" files contain the musical segments for
composition projects.

•  README.TXT

This file contains information on the latest program
updates, if there are any.

The SOUND.COM, C0MP0S1.EXE and C0MP0S1.RSR files
must always be in the current directory.

Before continuing, we suggest that you take a look at the
README.TXT file. To display this file:

1. Insert the diskette into drive A.

2. Type the following:

A>TYPE README.TXT

11
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Contents of the Diskette

NOTE: in this manual, all expressions that are to be typed on the
DOS should be typed as shown in the following example:

A>TEST

The standard type {A>) Indicates the computer's prompt
while the bold type (TEST) indicates what you have to enter.

Making Startup Diskettes

Before using Visual Composer, It Is essential that a copy be
made and that the original be put away Into a safe place.

To begin operating, the computer needs certain Information
that Is contained on startup diskettes. You are now going to
make two startup diskettes: the first one containing a copy of
the main core of the Visual Composer program and Its relevant
files; the second, the print utility program.

Before beginning, you will need two blank diskettes and a DOS
diskette containing the FORMAT program.

1. Insert the DOS diskette Into drive A.

2. Execute the FORMAT program and specify the /S option
which will Include a copy of the system files:

A>FORMAT B:/S

NOTE: Your DOS manual will give you all the details about the FORMAT
command and /S option.

12



Getting Started

Making Startup Diskettes

3. The FORMAT program will ask you to insert a blank
diskette into drive B.

4. When completed, the FORMAT program will ask you if
you want to format another diskette. Answer "Y" (Yes)
and then insert the second blank diskette.

5. When completed, the FORMAT program will once again
ask if you want to format another diskette. This time,
answer "N" (No).

6. Remove the DOS diskette from drive A and insert the
Visual Composer diskette.

7. Type:

A>VCINSTAL

The file VCINSTAL.BAT contains the sequence of DOS
commands necessary to make the startup diskettes.

First, the Visual Composer program and other related
files will be copied onto the blank diskette in drive B.

8. When this is done, you will be asked to insert the second
blank diskette and press the Return key. The printing
utility program will now be copied onto the second
diskette.

NOTE: These instructions apply to a double disk-drive system, if
you own a single disk-drive system, the COPY program will
ask you to make the necessary diskette changes.

13
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Installing Visual Composer onto a Hard Disk

Installing Visual Composer onto a Hard Disk

To install Visual Composer onto a hard disk, simply create a
directory and copy the entire contents of the Visual Composer
diskette into this directory.

1. Choose a name for your directory and type it in, for
example:

MD COMPOSER ^
This will create a directory named «Composer». ^

2. Make this directory the current directory: ^

CD COMPOSER ^

3. Insert the Visual Composer diskette into drive A and
copy the contents into the current directory:

COPY A:*.* ^

Loading the Program ^

1. Insert your Visual Composer startup diskette into drive A.

2. Turn on your computer (if it is already on, press the ^
and keys simultaneously to reset it). ^

Visual Composer will be automatically loaded.

OR,

Type the following in order to load Visual Composer ^
without resetting: ^
A>COMPOSER

14
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Using Visual Composer

This section answers ail the questions you are iikely to have
^  about Visual Composer. It tells you how to enter or edit music,

how to place your files in various directories, how to play back
music and how to print it.

Actions performed using Visual Composer are grouped into
four categories: entering music, listening, managing files and
printing. A part of this section is dedicated to each of these
categories. But before ail that, let's take a closer look at the

^  contents of the screen and at the way Visual Composer
commands work.

NOTE: In this manual, the following symbols refer to the
corresponding keys:

Backspace

^  E) Return
«  m Shift

19



Using Visual Composer

The Screen Display

The Screen Display

The following illustration shows what you will see on the screen
after having loaded Visual Composer.

JlBEdit Hi Playback BP Display (B Options BBHelp Q untitted|

1. Menu bar 9. Title of open file

2. Current mode indicator 10. Name of note where pen is located

3. Voice indicator bar 11. interpretation data bar

4. Grid 12. Pen

5. Piano keyboard 13. Dotted vertical lines separating beats

6. Mark indicating middle 0 14. Solid vertical lines separating measures

7. Numbers of 1st measure and 1st beat 15. Scroll boxes indicating part of piece
visible on grid displayed on screen

8. Clock symbol indicating momentary delay 16. Horizontal lines representing black
keys of the piano

20



Usinq Visual Composer

About Visual Composer's Commands

About Visual Composer's Commands

Most of Visual Composer's commands are categorized on
menus so that they can be easily located.

Menu Commands

Along the top of the screen, in the menu bar, are the titles of the
menus you can choose from. The keys which open each menu
are indicated at the left of each title.

:  (B File (B Edit [fl Playback BP Displajj H3 Options HB Help untitli

H 111 ® I 0 g 0 3 0 4 0 5 0 6 0 BP 0 SD 0 TO 0 CV 0 HH 0 AH ||~
j| Instr, fpiano 1



Usinq Visual Composer

About Visual Composer's Commands

Certain menu commands appear with a check mark beside
them, to indicate that they are already activated. These
commands are de-activated by simply choosing another
command of the same group, with the exception of the
command Audio Feedback which is activated and de-activated
aiternately by choosing it.

B File (B Edit (B Playback |ra|ila!lEM B3
IT||®1 0203040E Tempo
7  :—; ✓ instrumerit

^str. I fpianol

—  11 i i i I Pitch Accuracy

Bil Options I31il Help
b 0 CV 0 HH 0 All

Large Grid
Medium Grid

~  Small Grid

Ticks per Beat...
Beats per Measure...



'*** Using Visual Composer
About Visual Composer's Commands

Other menu commands are followed by an ellipsis (...)•
These commands need additional information to be carried
out. When one of these is chosen, a dialog box appears on

^  the screen. You then enter the appropriate information and
press the Q key to confirm your instructions. If you wish to
cancel these instructions, press the IHc) key.

^  To open and close menus

\  1. Press the function key given at the left of the desired
^  menu.

The title becomes highlighted and the menu containing
commands is displayed on the screen. Commands that are
not available at this time are dimmed.

2. Press the key.
The menu closes.

^  To choose a command from an open menu

^  1. Press one of the vertical arrow keys.

^  OR

Press the key which corresponds to the first letter of the
command.

The command you have chosen is highlighted.

^  NOTE: When more than one command begins with the same letter, Visual
Composer begins by highlighting the first one. If you press the same
key again, the next command starting with this letter becomes
highlighted.

^  23



Using Visual Composer

About Visual Composer's Commands

2. Press the Q key. ^
Your choice is confirmed and the command you have chosen ^
is carried out.

NOTE: You can move from one open menu to another by pressing ^
one of the horizontal arrow keys.

Keyboard Commands

Some commands do not appear in the menus and can only be
carried out by using the keyboard: commands used to open
menus, choose a mode of operation, move cursors and
activate voices. These commands are explained when needed ^
in the section entitled "Using Visual Composer" and described
systematically in the References section. ^

Most menu commands can also be carried out by shortcuts
-a key sequence on the keyboard- without opening the menu
itself. Open the different menus to see these key sequences: ^
they are indicated to the right of the command name. ^

24



Using Visual Composer

Entering Music

Entering Music

As a rule, written music includes two kinds of information: the
notes to be played and indications as to how to play them.

With Visual Composer, notes are represented by dashes which
you "draw" on a grid. The length of the notes is determined by
the length of these dashes. Their pitch depends on their
position on the grid: high notes are entered at the top of the
grid and low notes, at the bottom.

Once you have entered notes onto the grid, you will want to
indicate how you would like them played. You might want
some of the notes to be louder, for instance, or to have some of
the sections played faster. Visual Composer lets you indicate
changes in tempo, volume, instruments and pitch accuracy.
We refer to everything dealing with how to play the music as
"interpretation data". The place for entering interpretation data
is called the interpretation data bar.

Visual Composer, therefore, involves two distinct music writing
activities: entering notes on the grid and entering interpretation
data in the interpretation data bar.

25



Using Visual Composer

Entering Music

The (ZD and (iD keys are used to choose these two activities
respectiveiy. Each activity implies a different mode of
operation: the current mode is always indicated by a
highlighted symbol in the upper left-hand corner of the screen.

26

Selector Symbol •

Pen Symbot -

Interpretation Data
Current Category -

G9 Edit 19 Playback 60 DkIS File

02 03 04 05 06

f piano 1

(sm,

There is another activity with Visual Composer, called
"selection". Selection involves choosing a group of notes in
order to work on it. This activity implies the mode of operation
which we refer to as Select Mode; this mode is chosen by
pressing the (ID key. We will be explaining Select Mode and
when to use it on page 47.



Using Visual Composer

Entering Music

^  Entering Notes

/fm, With Visual Composer, notes are entered on a grid, using a
"pen". The notes you enter will always belong to a specific
voice; a row of indicators constantly reminds you which is the
active voice.

NOTE: If you have a MIDI interface, you can also enter notes directly
by playing on your MIDI keyboard. To learn how to use MIDI
with Visual Composer, consult Appendix D on page 125.

The grid

The grid, which takes up most of the screen, is the place where
notes are entered. It consists of vertical and horizontal lines
which serve as reference points when reading and entering
notes.

The horizontal lines correspond to the black keys of the piano
displayed along the left edge of the grid. The dotted vertical

^  lines separate beats and the solid vertical lines separate
^  measures.

Before entering a piece, you may determine the desired
^  number of beats per measure and the desired number of ticks

per beat (a tick being the smallest division of a beat required
within a given piece).

/mm,
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Using Visual Composer

Entering Music

To change the number of ticks per beat and beats per measure

1. Open the Display menu.

2. Choose the command Ticks per Beat or Beats per
Measure .

A dialog box appears highlighting the current number of ticks
per beat or beats per measure.

3. Type the desired number on the alphanumeric
keyboard.
The number of ticks per beat determines the length of the
shortest note you will be using, while the number of beats
per measure determines the number of beats each measure
will contain.

4. Press the ED key-
This confirms your instructions and the grid is adjusted
accordingly.

The grid can also be adjusted to three different sizes according
to your needs: large, medium and fine. The large grid gives
you big notes while the fine grid lets you see a larger
proportion of the open file on the screen.

2 8



Using Visual Composer

Entering Music

^  To change the grid size

1. Open the Display menu.

2. Choose one of the three grid sizes offered.

^  3. Press the (3 key.
This confirms your choice and the grid is adjusted

^  accordingly.

^  The pen

To use the pen, you must first activate the Write Mode by
pressing the ££] key. The pen symbol is then highlighted in

^  the upper left-hand corner of the screen and a cursor we call a
"pen" appears in the grid.

This pen is located on a vertical cursor bar and moves
^  horizontally as well as vertically. You may write or delete notes

with the pen.

To move the pen horizontally

Press one of the horizontal arrow keys (Q, Q)-
The pen moves to the left or the right depending on which
key you have pressed. It moves a distance equal to one tick.

«  29



Using Visual Composer

Entering Music

fPP\

You can also move the pen quickly over greater distances. »
You can move it directly to the neighboring beat line by holding
down the (ct^ key while you press the arrow key. You can also
move it to the neighboring bar-line by pressing the Q or Q ^
key of the numeric keypad. For information on other quick- ^
move commands, see References section on page 87 and ^
"Scrolling" on page 56.

To move the pen vertically

Press one of the vertical arrow keys (Q, D)-
The pen moves up or down a semitone depending on which
key you have pressed. ^

You can also move the pen one octave at a time or move it —
directly to a specific note.

To move it one octave, press the iPg^H or iPgO"! key. ^
To move it directly to a specific note, press the key that
corresponds to the note.

A: B: (13 C: (□ D: (13
E: 13 F: (□ G: (13

fmms

30

When you press one of these letter keys more than once, the ^
pen keeps going up another octave until it reaches the top of
the window. It then goes to the specified note at the bottom of
the window.

(IWi,



Using Visual Composer

^  Entering Music

^  To enter notes

•  Hold down the key and press one of the horizontal
/■i^ arrow keys (Q, Q).
^  A black dash one tick long appears at pen level.

^  ' If you press the same horizontal arrow key once more
^  without letting go of the (3 key, the dash becomes one

tick longer.

NOTE: When you enter notes, the pen can also be moved directly
^  by beats or measures, as described in the paragraph 'To

move the pen horizontally" on page 30.

To delete notes

1. Move the pen to the immediate right of a dash.

^  2. Press the key once for each tick to be erased.
«  OR

^  1. Place the pen at either side of a dash.

2. Hold down the key and press the appropriate
horizontal arrow key once for each tick to be erased.

31



Using Visual Composer

Entering Music

Practice entering notes on the grid by reproducing the dashes
displayed in the following illustration:

lF8l!mFHF9lOptions

<D 1 0 2 0 3 0 4 0 5 0 6 0 BD 0 SO 0 TO 0 CV 0 HH 0

f piano 1

Once they have been entered, listen to them by using the
command Play from the Playback menu. You will certainly
recognize a famous little melody.



Using Visual Composer

Entering Music

Entering Interpretation Data

Interpretation data is the information that Visual Composer is
given on how to play notes. There are four categories of
interpretation data: changes in volume, tempo, pitch accuracy
and instrument.

Only one category of interpretation data can be displayed and
edited at one time. The place where this information is
displayed and edited is called the interpretation data bar.

To enter interpretation data, you must first activate the
interpretation data mode by pressing the (10 key. The name of
the active data category is then highlighted in the upper left-
hand corner of the screen, and a cursor appears in the
interpretation data bar.

The changes entered in this bar apply only to the active voice,
with the exception of tempo changes, which apply to all voices.
These changes can be made as many times as you like within
the same melody - on each note or even on each tick.

NOTE: When a new file is opened, the interpretation data bar shows
a default value for each data category. These values are
described below with the instructions related to each of

these categories.

33



Using Visual Composer ^
Entering Music

—  (mm,

To enter or modify interpretation data ^

1. Press the key to activate the interpretation data
mode of operation.

2. Choose the desired interpretation data category in the
Display menu. ^
A check mark appears beside the interpretation data
category chosen and its name appears to the left of the
interpretation data bar.

3. Press one of the horizontal arrow keys so that the cursor
is placed at the desired position in the interpretation
data bar. ^
The cursor moves one tick at a time. However, you can make
it jump further if you wish (see Quick-Move Commands on
page 87). ^

4. Press the (3 key to open an edit field.
A black rectangle (the edit field) appears at cursor position.
This is where the desired data is to be entered. This edit field

is then closed by pressing the key.
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Using Visual Composer

Entering Music

To delete interpretation data

1. Press the (rD key. if the interpretation data mode of
operation is not already active.

2. Press the Q key to open an edit field at the desired
position.

3. Press the key to clear this edit field.

4. Press the (3 key to close it.

The characteristics of each of the interpretation data categories
are described below.

To enter tempo changes

Tempo changes are for slowing down or speeding up music as
it is played. Only mechanical music is played without any
variation in tempo. You will want to use this item in Visual
Composer to make your music sound more natural -rhore
"human".

1. Press the (rD key, if the interpretation data mode
of operation is not already active.

2. Choose the command Tempo from the Display
menu.

The word Tempo appears to the left of the data bar.

3. Place the cursor where you wish to make a tempo
change, and press the (3 key to open an edit field.

35



Usina Visual Composer

Enterinq Music

4. Enter a numeric value from 0.01 to 10.0.
Tempo changes are expressed in relation to a basic tempo
established by the command Basic Tempo of the Playback
menu. For instance, 0.5 is half of the basic tempo and 5 is
five times faster than the basic tempo.

5. Press the (3 key to confirm.
The edit field is closed and the numeric value that you
entered appears at the desired place.

The following illustration involves tempo changes. Practice
making these changes by entering the data seen in this
illustration and listen to the results.

Edit GB Plaijback BP Display B3 Options BE) Help

(J> I 0 2 0 3 0 4 0 5 0 6 0 BD 0 SO 0 TO 0 CV 0 Hh

^0^90



Using Visual Composer

Entering Music

To enter pitch accuracy changes

When two similar instruments play the same notes
simultaneously, we can clearly distinguish both of them
because they are not playing accurately at the same pitch. If
there is a big difference in pitch accuracy, they would sound
out of tune with each other. However, a very slight difference
enriches the sound. You will be using the command Pitch
Accuracy in order to attain this richness of tone found in live
music, or to create special detuning effects, as you will see
below.

1. Press the (iO key, if the interpretation data mode of
operation is not already active.

2. Choose the command Pitch Accuracy from the Display
menu.

The word Pitch appears to the left of the data bar.

3. Place the cursor at the desired position in the
Interpretation Data bar.

4. Press the (3 key to open an edit field.

5. Enter a numeric value that corresponds to the desired
pitch deviation of the accurate sound.
The deviation scale goes from the values of 0.0 to 2.0. The
number 1.0 represents the accurate sound; the number 0.0
takes the sound one semitone down; the number 2.0 moves
the sound one semitone up. Ail intermediate values are
permitted, making it possible to create effects from one
extreme to the other. Generally speaking, a deviation of
about 0.1 between two voices in unison is sufficient to create

rich effects.
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Entering Music

6. Press the (il] key to confirm.
The edit field is closed and the numeric value you entered
appears in the desired place.

The following Illustration deals with changes made to the pitch
accuracy. Practice making these changes by entering the data
seen In this Illustration and listen to the results.

File (S Edit IB Playback QD Display (xj Options

(i)l 02 03 04 05 06 OBDOSDOTGOCVO

rl.O fO.50 fO.30



Using Visual Composer

Entering Music

To enter volume changes

Changes In volume produce what musicians refer to as
"dynamics". Dynamics are often used to enhance music.
You can introduce your own by using the command Volume of
Visual Composer.

1. Press the (ID key. if the interpretation data mode of
operation is not already active.

2  Choose the command Volume from the Display menu.
The word Volume (Vol.) appears to the left of the data bar.

3. Place the cursor at the desired position in the
Interpretation Data bar.

4. Press the (3 key to open an edit field.

5. Enter a numeric value from 0.0 to 1.0.
The value entered here modifies the basic volume

determined by the external volume control of the Ad Lib
Synthesizer Card. The number 1.0 represents the maximum
volume possible with the current setting of the card volume
control, while 0.0 represents no volume. All intermediate
values are permitted, creating dynamics from one extreme to
the other. The default volume setting for all voices is 0.75.

6. Press the O key to confirm.
The edit field is closed and the numeric value you entered
appears in the desired place.
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The following illustration deals with volume changes. Practice
rhaking these changes by entering the data seen in this
illustration and listen to the results.

File IS Edit IB Playback QD Display S] Options QEl Help

(S)l 02030405060 BDOSDO TO OCVOt

rO.75



Using Visual Composer

Entering Music

To enter instrument changes

Choosing the instruments for the different sections of a
composition is referred to by musicians as "orchestration". You
can "orchestrate" your own compositions using the instrument
feature of Visual Composer.

1. Press the dD key, if the interpretation data mode of
operation is not already activated.

2. Choose the command Instrument from the Display
menu.

The word Instmment (Instr.) appears to the left of the data bar.

3. Place the cursor at the desired position in the
Interpretation Data bar and press the Q key to open
an edit field.

4. Press the key to obtain the list of available
instruments.

A list of the available instruments in the linked instrument

directory is displayed on the screen.

5. Choose an instrument from this list using the vertical
arrow keys.

6. Press the CED key to confirm your choice.
The name of the chosen instrument appears inside the open
edit field, and the edit field closes.

NOTE: It is also possible to directly type the name of an available
instrument in the edit field, instead of refering to the list with the
1^ key. If you do so, be sure of the spelling of the desired
instrument name, because any small difference wili produce an
error message at the time of playing back the music.
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The following Illustration deals with instrument changes.
Practice making these changes by entering the data seen in
this illustration and listen to the results.

B File IB Edit jfl Plajjback BP Display 53 Options HE) Help tmink

7 III ^ ' 0 5 0 3 0 ̂ 0 5 0 ̂ 0 BP 0 SD 0 TO 0 CV 0 HH 0 Rll || "T
3 fpiano 1

NOTE: You can add new sounds created with the Ad Lib Instrument

Maker to the Visual Composer instrument list. To find out
how to do this, read the section entitled "Using a New Sound
with Visual Composer" in the Instrument Maker manual.
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Writing for Several Voices

Visual Composer lets you enter up to eleven volcesto be
played simultaneously. A row of indicators at the top of the
screen constantly reminds you which voice is active.

You can choose from one of the two following voice assortment
options: With Percussion; Without Percussion. The first gives
you the possibility of using six melodic voices and five
percussion voices while the second offers nine melodic voices
but no percussion.

The preset assortment is With Percussion.

^  To choose the Without Percussion voice assortment

^  • Select the command Without Percussion from the
^  Options menu.
^  The row of voice indicators displays nine indicators

numbered from 1 to 9. Indicator No. 1 is highlighted.
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To choose the With Percussion voice assortment

•  Select the command With Percussion from the Options
menu.

The row of voioe indicators dispiays six indicators numbered
from 1 to 6 and five indicators followed by the abbreviations
below:

BD for the Bass Drum

TO for the Tom-Tom

SO for the Snare Drum

CY for the Cymbals
HH for the Hi-Hat

indicator No.1 is highlighted.

The pitch of the SD, CY and HH voices is fixed and ^
independant of the position at which they are written on the ^
grid. However, the BD and TT voices can vary in pitch. ^

Furthermore, the TT influences the timbre of the fixed voices.
To obtain the best results, it is a good idea to place the notes of
this voice on the note 0, located two octaves below middle 0.
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^  To activate a given voice

^  • Hold down the key and press the number key
^  corresponding to the desired voice: percussion voices
^  are activated by keys CD, CD. CD. Q. and CD • (As the

numeric keypad is currently being used for the arrow
keys, you must use the number keys of the
alphanumeric keyboard.)
The notes and the indicator for the chosen voice are

highlighted and the notes written in the other voices are
(«»* dimmed. Ali commands of the three Modes of operation wiil
^  appiy to this voice.

NOTE: The information given in the interpretation data bar is related
^  to the active voice except for tempo changes, which affect aii
_  voices.

^  To activate all voices simultaneously

-*"1 ' Hold down the key and press the CD key-
The "All" indicator is highiighted.

'*** NOTE: Choosing aii voices is useful when working on sections, as
you will see further on. However, it is impossibie to write
when "Aii" voices are active. If you attempt to do so, Visual

^  Composer will display an error message.
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Experiment with the possibilities of writing different voices;
enter an accompaniment for the melody you wrote previously.
To do this, select voice No. 2 and reproduce the black dashes
which are seen in the illustration below. Then listen to the

whole piece while following these dashes on the screen.

Playback QD Display

01 02 03 04 05 06 0B[

f piano I

Options
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Working on Sections

As you use Visual Composer, you will soon feel the need to
perform operations on whole sections of music. To do so, you
will have to, first of all, select the desired group of notes and
then choose a command to be applied to this selection.

We are now going to see:

selection methods

instructions for repeating, deleting, moving and
transposing a selected group of notes.

Selection Methods

Selection involves choosing a group of notes in order to work
on them. The mode of operation used to perform this action is
called Select Mode and is chosen by pressing the (ZD key.
Once chosen, a cursor bar we call a "selector" appears on the
grid and a corresponding symbol is highlighted in the upper
left-hand corner of the screen.

When you "select" notes, a highlighted area appears all the
way up the grid. However, it is only the active voice of this
section that is being selected.

NOTE: When the option "All" located on the voice indicator bar is
highiighted, selection applies to ail voices.
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To select a section in a given voice

1. Activate the desired voice.

2. Press the (r^ key to activate the Select Mode.

Place the selector at either edge of the desired group of
notes.

4. Hold down the key and press the appropriate
horizontal keys (Q or Q)-
The selected part of the grid becomes highlighted.

NOTE: You can aiso move the selector over greater distances, by
applying the methods for Quick-Move Commands. (See
References page 87.)

To select a section in all voices

1. Activate All voices.

2. Press the (rz] key to activate the Select Mode.

3. Place the selector at either edge of the desired group of
notes.

4. Hold down the key and press the appropriate
horizontal arrow key (Q. Q)-
The selected part of the grid becomes highlighted and
concerns all voices.
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To disengage a selection

Press the space bar.
The selection is disengaged and the seiector stays at the same
place.

OR

♦ Press any key or key sequence used for moving the
cursor.

The selection is disengaged and the selector is displaced in
keeping with the requested move.

Repeating, Deleting, Moving and Transposing Sections

To repeat, delete and move sections, you will often use the
commands Cut, Copy and Paste from the Edit menu. These
commands use a part of the computer's memory we refer to as
the "selection buffer".

Cut:

This command removes the selected group of notes from the
grid and places it in the selection buffer. The place occupied
by the removed section is then filled up with the notes
previously located to the right.

Copy:
This command places a copy of the selected group of notes in

^  the selection buffer.
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Paste:

This command uses a copy of the section placed in the
seiection buffer by means of the command Cut or Copy and
inserts it at the cursor position in the piece. The notes located
to the right of the insertion are shifted further right. Since the
command Paste uses only a copy of the selection buffer
contents, you can paste the same thing again eisewhere, if you
so desire.

NOTE: The selection buffer can only contain one section at a time.
This means that when it receives a new section, the old one
is replaced. The selection buffer contents stay intact until
you reset or turn off your computer.

When using the commands Cut and Paste, bear in mind that
the resulting shifting of the notes located to the right of the
cursor may disorganize the vertical correspondances between
voices if it is not performed on all voices at once.

To repeat a section

• Within a given voice

1. Press the (rlD key to activate the Select Mode.

2. Select the desired notes.

3. Choose Copy from the Edit menu.
A copy of the selected section goes into the selection buffer.

4. Place the selector at the desired position on the grid or
select the section you wish to repiace.
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5. Choose the command Paste from the Edit menu and

press the [£) key to confirm.
A copy of the selection buffer contents appears where you
have positioned the selector, or replaces the selected
section, depending on the case. The selector remains at the
beginning of the pasted section.

•  From one voice to another

1. Press the (ii] key to activate the Select Mode.

2. Select the desired notes of a given voice.

3. Choose the command Copy from the Edit menu.
A copy of the selected notes goes into the selection buffer.

4. Activate a new voice.

5. Place the selector at the desired position on the grid.

6. Choose Paste from the Edit menu and press the Q key
to confirm.

To delete a section

1. Press the (ID key to acvtivate the Select Mode.

2. Select the desired notes.

Choose the command Cut or Clear from the Edit menu

and press the E) key to confirm.
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When you choose the command Cut, the notes that are placed
to the right of the selection move to fill in the space created by
the cut. This "compression" only occurs in the active voice.

When you choose the command Clear, the notes placed to the
right of the selection stay where they are. This means that the
command Clear creates a gap in the music - but only in the
active voice. The command Clear does not utilize the selection
buffer and therefore, leaves its contents intact. Consequently,
a cleared section can not be recovered.

To move a section

• Within a given voice

1. Press the (ID key to activate the Select Mode.

2. Select the desired notes.

3. Choose Cut from the Edit menu.

4. Place the selector at the desired position on the grid.

OR

Select the group of notes you wish to replace.

5. Choose Paste from the Edit menu and press the ED key
to confirm.
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^  • From one voice to another

1. Press the liD key to activate the Select Mode.

2. Select the desired notes in the original voice.

^  3. Choose the command Cut from the Edit menu.

4. Activate the target voice.

^  5. Place the cursor at the desired position.

6. Choose the command Paste from the Edit menu and

^  press the Q key to confirm.

NOTE: When moving a section, you must always paste it in the same
context as the original one. For instance, if there were only

^  one active voice at the time of the Cut or Copy, you must
paste the contents of the selection memory at a time where

^  there is only one active voice. By the same token, when all
^  voices are active in the original context, they also all have to

be active in the new one.

To transfer a section from one file to another

The commands Copy, Cut and Paste may also be used
between two files. If such is the case, upon opening the
second file, make sure that the Select Mode has been chosen
before continuing. Otherwise, the command Paste will remain
dimmed, that is to say, unavailable.
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To transpose a section

Transposition consists of moving a group of notes vertically.
Visual Composer enables you to transpose a selection up or
down whether it be a semitone or an octave at the time.

1. Select the desired notes.

2. Choose one of the four transposing commands of the
Edit menu (Semitone Up, Semitone Down, Octave Up,
Octave Down) and press the [d] key to confirm.

FiIe (S Edit (S Playback GO Display (£] Options QQ Help tiiiinkle :
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Experiment with transposing a group of notes. Once the group
of notes has been selected (see preceding illustration), choose
the command Octave Up in the Edit menu.^ When transposed,
the section should be displayed as shown in the following
illustration:

Edit (B Playback SO Display Options

(5) 1 02030405060 BDO SO 0 TO OCVQHH 0

rpianol f trumpet!

NOTE: Transposing a selection, unlike the commands Cut, Copy
and Paste, does not involve the selection buffer.
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Scrolling

Generally speaking, the Visual Composer window cannot
display your entire composition at once - the piece usually
contains too much information to fit in.

Window Music

There are a number of commands you can use to scroll
through your music, whatever the mode of operation involved.
On the screen, there are two grey bars with scrolling indicators
in them (white boxes): one on the right-hand side, the other on
the bottom. These indicators show you which part of the piece
is displayed in the window. If the indicator is located in the
middle of the horizontal scroll bar, for instance, this means that
the window's contents are found half-way through the piece. If
the indicator is located in the middle of the vertical scroll bar,
this means that the window contents are found in the middle of
the pitch range.
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To move the window up or down an octave

^  • Hold down the key and press the lPg"H or iPgO"! key.
The window moves up or down. If you are working in Write
Mode, the pen remains in position .

To move to the neighboring pages

^  • Press the IhowM key or 1^"" I key.
^  The cursor moves to the left or right edge of the grid. If you
^  press the same key once more, the cursor goes to the left or

right edge of a new page, shifting the entire contents of the
^  window to the left or the right.

To move directly to the beginning or the end of a piece

Hold down the (ctn] key and press the lnomH or
[E"" I key.

^  NOTE: As interpretation data stays valid until the next change, this data
^  will be displayed in parenthesis on the left-hand side of the

interpretation data bar when scrolling to later parts of a piece.
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Listening to the Music

You will now see various commands used to listen to what you
have written. Visual Composer enables you to hear up to 11
simultaneous voices; however, you can also listen to one voice
by itself, one section by itself, or even one voice of a section by
itself.

When using one of the two available commands to play back
music, the program loads the music you asked to hear into a
sound memory buffer. During this time, a clock appears at the
top of the screen, to the right of the menu titles. For as long as
you see this clock, the program will not respond to any
commands. Once it has disappeared, the program is ready to
accept further commands.

To listen to an entire piece

1. Select the command Play from the Playback menu.

2. Press the EJ key to confirm.
You will hear the entire piece.

To listen to a given voice

1. Select the command Play Voice from the Playback
menu.

2. Press the (3 key to confirm.
You hear the active voice of the piece.
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^  To listen to a given section

^  1. Select a group of notes.
^  2. Select the command Play from the Playback menu.

^  3. Press the (3 key to confirm.
^  You hear the selected section.

To iisten to a given voice of a given section

1. Select a group of notes.

2. Select the command Play Voice from the Playback
menu.

3. Press the (3 key to confirm.
You hear the active voice of the selected section.

^  To interrupt the piayback

•  During the playback of a piece, select the command
«  Interrupt from the Playback menu.
^  The piece automatically stops playing.

NOTE: If there is a clock symbol at the top of the screen, the music
^  will only stop playing once this symbol has disappeared.
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Managing Files

The commands used for managing files are found in the File
menu. You will often use these commands, whether you are
saving your work, opening a new file, finding a piece
previously saved, or linking the program to the directories of
your choice.

To open a new file

Choose the command New in the File menu,
if there are no modifications to be saved in the already
opened file, Visual Composer closes this file and opens a
new untitled one. If you made changes In the already
opened file and have not saved them, Visual Composer will
first ask you if you wish to save this file. Upon receiving your
answer, Visual Composer closes the open file and opens a
new untitled one.

To open an existing file

1. Choose the command Open in the File menu.
If there are no modifications to be saved In the already
opened file, Visual Composer closes this file and displays the
list of available files In the current directory.

If you have made changes in the already opened file and
have not saved them. Visual Composer will first ask you if you
wish to save this file. Upon receiving your answer, Visual
Composer closes the open file and displays the list of files in
the current directory.
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^  2. Choose a name in this list.
To choose a name, press the vertical arrow keys (Q and

These keys will scroll the file in the dialog box if the list
of titles is too long. You may also use an alphabetic key to
jump to the first file name starting with this letter.

r

^  To save a file

Press the E] key to confirm the choice.
A copy of the chosen piece appears on the screen and its
title is displayed at the right-hand side of the menu bar.

1. Select the command Save from the File menu.

If this piece is being saved for the first time, a dialog box
appears and asks you under what name you wish to save it.
This name will become the title of the open file. (For more
details, see below: "To save a file under a new name".)

If this is not the first time that this piece is being saved.
Visual Composer replaces the old version, with the current
one. If, however, you want to keep the old version, use the
command Save As, and rename the new version.

2. Press the E] key to confirm.
Your piece is now saved in the file whose name is at the right-

^  hand side of the menu bar.
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To save a file under a new name

1. Choose the command Save As from the file
menu.

A dialog box appears, displaying the name of the current
open file.

2. Type in the new name and press the EJ key to confirm
your choice.
The new name is shown in the box; when you press the S
key, the box closes and the new name is displayed at the
right-hand side of the menu bar. If you give this file the same
name as another existing file, a dialog box asks you to
confirm whether or not you want to replace this other file with
the new one.

NOTE: Not all characters are permitted in the choice of a title. If you
use a non-authorized character, a warning signal will let you
know. On page 94, you will see which characters are
available when choosing a file name.

To Sink a file fo a new directory

To classify musical files, you will most likely group your pieces
into different directories. (To create several directories on the ^
same diskette, see the MD or MKDIR DOS command.) Here's ^
how to link Visual Composer to a different directory:
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1. Choose the command Music File Directory from
the File menu.

A dialog box appears, showing you the current directory
name.

2. Type the desired name, abiding by the DOS
conventions.

3. Press the E) key to confirm your choice.
From now on, the program is linked to this new directory.

The file list that appears when the command Open is made
now displays the files belonging to this new directory. The next
time you save a piece, it will be placed into this directory.

Printing Music

^  Visual Composer printing features are available through an
independant printing utility program included on the diskette
and entitled VCPRINT.

This program enables entire pieces or simply parts of a piece
(a voice, a section, etc.) to be printed in the form of dashes on a
grid, as seen on the screen. You may also obtain a separate
print-out of desired interpretation data, either in complete or
condensed form.

NOTE: Visual Composer operates with a printer of the "IBM Graphics
Black and White" variety, or any compatible printer.
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To load the print utility program

in order to load the print utility program, you must type
VCPRINT at the DOS prompt and press the Q key to
confirm.

The program then displays on the screen the first of a series
of messages about the data to be printed.

NOTE: If you are using Visual Composer, you must first of ail quit the
program to get into the DOS.

To print a file

Here is the list of messages that will appear on the
screen, together with explanations.

File to print

When you see this message, type the name of the file
you wish to print and press the ED to confirm. If this file
is not included in the current directory, begin by typing
the name of the directory that does contain the file.
(Abide by the DOS conventions.)

Formula: <drive> : \ <directory> \ <file>

Example: A:\COMPROJ\HAPPY
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Notes (N) or Data (D)

This message offers the choice of printing notes or
Interpretation data. To make your choice, type one of
the two letters placed In parenthesis, and press the [3
key.

If you choose to print notes, the print-out will be a copy of
what appears on the grid.

If you choose to print Interpretation data, the print-out will
be a list of alphanumeric values. These values
represent Interpretation data changes. When the print
out doesn't start at the beginning of the piece (as you
may ask for), the last data change that took place (at
some earlier stage of the composition) Is displayed In
parenthesis.

If you press the (3 key, without having chosen either an
"N" or a "D", notes will be printed.

•  Voice (All; 1 to 6; BD; SO; TO; CY; HH)

OR

Voice (All; 1 to 9)

The first message appears when the file to be printed
contains percussion voices; the second appears when
the file to be printed contains only melodic voices.
These two messages make It possible to choose the
voice or voices that you want to print.
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Make a choice by typing one or several of the elements
listed in parenthesis. If you want to print more than one
voice, separate the elements with a space.

When you press the (3 key without having chosen any
voices, all the voices will be printed.

Interpretation data (T; V; P; I)

This message appears when you have chosen to print
interpretation data with more than one voice. In this
case, only one category of data will be printed at a time.
(T for Tempo, V for Volume, Pfor Pitch Accuracy, I for
Instruments.)

To choose the category of data to be printed, enter one
of the letters listed in parenthesis. For each voice that
includes data of the chosen type, a list of values will be
printed. (There will be only one series of values if T is
chosen, because tempo data is the same for all voices.)

From measure...

This message asks you to choose the measure at which
printing is to begin. Type in the number corresponding
to this measure and press the (3 key.

When you press the (3 key without having entered a
number, printing will start at the very beginning of the
piece.
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To measure...

This message asks you to choose the measure at which
printing is to end. Type in the number corresponding to
this measure and press the (3 key.

When you press the 3 key without having entered a
number, printing will continue to the very end of the
piece.

Condensed print-out (Y or N)

This message appears when you have chosen to print
interpretation data. You may then choose to have a
condensed or a complete print-out made by typing the
appropriate letter (Y for Yes; N for No).

On a condensed print-out, only ticks containing a
change will be printed. On a complete print-out, each
tick will be printed.

When you press the (3 key, without having chosen "Y"
or "N", a condensed print-out is made.

Press Esc to cancel printing.

This message will be the last message to appear
when you have chosen to print notes or data. It
lets you stop the printing process at any time.
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Writing a Piece: A Step-By-Step Example

^  Opening a new file

We are now going to write a piece using Visual Composer.
The music we have chosen is an excerpt from the song "Happy
Birthday to You".

Opening a new file

1. Press the (iO key to open the File menu.

^  2. Choose the command New and press the Q key to
confirm.

A new and empty file page is displayed on the screen.

^  Note that the grid shows four beats per measure. The song
^  "Happy Birthday to You" has three beats per measure. We are
^  therefore going to change the grid accordingly.

Changing the grid

1. Press the (!D key.
This opens the Display menu .

2. Press the O key until the command Beats per Measure
is highlighted.

3. Press the Q key to confirm.
A dialog box then appears asking you how many beats you
want each measure to have.
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Changing the grid

4. Type the number 3.
The number 3 is entered into the dialog box.

5. Press the Q key to confirm.
The grid now shows 3 beats per measure.

Everything is now ready for you to enter the song. We are
going to begin by entering the melody, after which we will enter
the accompaniment.

Entering the melody

The pen is located at the beginning of the l3t measure, on a C.
The chosen song begins on the 3''^ beat of this measure, on a
G . We are now going to move the pen to the 3rd beat and then
place it on the G .

1. Press the Q key eight times to put the pen on the 2nd
dotted line.

This line marks the beginning of the 3rd beat.

2. Press the Q key seven times to place the pen on the G
above middle C. Middle C is indicated on the piano
keyboard by a grey mark.
Watch the names of the notes as they change in the box
under the title of the piece in the upper right-hand corner of
the screen.

3. Hold down the key and press the Q key three
times.

You have just entered the first note of the melody: a G three
ticks long.
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Entering the melody

4. Release the key. Hold it down again and press the
Q key one more time.
You have now entered the 2nd note of the melody: a G 1 tick
long.

NOTE: Should you make a mistake, you can delete a note by placing
the pen to Its Immediate right and pressing the key.

The pen is now placed at the beginning of the 2"^ measure,
on G.

1. Press the (O key twice to move the pen up to A.

2. Holding down the key, press the Q key 4 times in a
row and then let go of the key.
You have entered an A1 beat long.

3. Press the O key twice to place the pen on G and enter
a note 1 beat long (4 ticks).

4. Press the Q key 5 times to move the pen to C and
enter a note 1 beat long (4 ticks).

5. Press the Q key once so that the pen is placed on B
and enter a note 2 beats long (8 ticks).

The pen is now placed in the measure, at the beginning of
the 3^"^ beat. If you have followed the exercise carefully, you
will now know how to enter notes of different lengths and at
different heights.
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Entering the melody

Example

All the other notes in this melody will be written in the same
way: for a one tick note, press the horizontal arrow key once;
for a four tick note, press this key four times. To enter two
individual notes of the same pitch, let go of the key
between the two notes and, after you have pressed it again
and are holding it down, continue to write. Visual Composer
will show a small gap between these two notes found at the
same height.

To finish writing the melody that we began together, add the
dashes shown in the following illustration to what you have
already entered on the screen.

:  (S File IS Edit (B Playback (B Display Options SQ Help happy::B III ® I 0 a 0 3 0 4 0 5 0 6 0 BP 0 SO 0 TO 0 CV 0 HH Q fill jj C
tr. f trumpet I I

You will now listen to the song you have entered.



Writing a Piece: A Step-By-Step Example

Playing back

/rnrn^

Playing back

1. Press the dD key.
This opens the Playback menu.

Press the O key in order to highlight the command
Play.

Press the Q key to confirm.
You will now hear the music you just entered.

The sound you hear is that of a piano. We are now
going to replace this "piano" by a "trumpet" to give the
song a different feeling.

Changing the Instrument

^  1. Press the 1^ key to ensure that the cursor is at the
beginning of the piece.
The pen is placed on the left edge of the grid.

^  2. Press the IZD key to choose the Interpretation Data Mode
^  of operation.

A cursor appears at the ieft-hand side of the interpretation
'*** data bar and the word "Instr." is highlighted in the box piaced

to the left of this bar.

^  3. Press the (3 key to open an edit field.
A black rectangle - the edit field - appears in the bar where

^  the cursor was. The name of the instrument already chosen,
"piano! is shown highlighted in this rectangle.

^  75



Writing a Piece: A Step-By-Step Example

Changing the instrument

4. Type the word "trumpetr to replace the piano. ^
The word "trumpett" replaces the word "pianot ^

5. Press the ED key to close the edit field and confirm your
instruction.

6. Play back your melody once again. ^
it is now played by a trumpet.

You would probably like this song even better if it had an
accompaniment.

Entering the bass line accompaniment

The notes indicated in the following illustration represent the
bass line accompaniment. Before you begin to enter these
notes, you must change the voice number so that these new
notes will not replace the notes already entered.

(mm

1. Hold down the IS key and press the CD key in
order to change the active voice.
The indicator for voice No. 2 is highlighted and the notes ^
entered in voice No. 1 are dimmed. ^

2. After having re-activated the Write Mode ((iD). carefully
enter the notes in the following illustration:

76



Writinq a Piece: A Step-Bv-Step Example

Enterinq a bass line accompaniment

IS File IS Edit IB Playback Qj Display Qj Options

OI (5)2O3O4O5O6OBDOSDOT0OCVOHH 0

rbassooni

3. Now change the preset instrument (Piand) to a
bassoon (Bassoon!) applying the same method used
earlier to change the piano to a trumpet in the first voice.

4. Listen to the results.

To finish off, we are going to add a touch of the snare drum to
this piece to liven it up a bit. To enter percussion notes, you
must always choose the percussion voice that corresponds to
the instrument of your choice.



Writing a Piece: A Step-By-Step Example

Entering percussion accompaniment

Enterinq percussion accompaniment

1. Hold down the key and press the CD key.
The (D key corresponds to the snare drum voice, indicated
by the symbol SD on the screen. The SD voice indicator is
now highlighted and the notes entered in voices No. 1 and
No. 2 are dimmed. The name of the instrument displayed in
the data bar is now "SnareT".

2. Carefully enter the notes in the illustration below.

3. Listen to the results.

B File IB Edit ffl Playback BP Display B) Options HB Help
11II 01 0 2 03 0 4 0 5 0 6 QBD (j)SD OTP QCV QHH Of
istr. fsnare I

lUIUIIlliljlUlllllllllliniNj

•iiiiiiiiDuii iin liiiiiitiiiiiiiiii^



Writing a Piece: A Step-By-Step Example

Entering percussion accompaniment

Your piece now has three voices. Before you go any further,
It would be a good Idea to save this piece to make sure you
don't loose all the work you have done.

Saving

1. Press the (ZD key.
This opens the File menu.

2. Press the (O key 3 times to choose the command Save.

3. Press the (3 key to confirm your choice.
A dialog box will appear asking you to name your piece. The
name you choose will be the title of the open file.

4. Type a name.
This name is entered in the dialog box.

5. Press the [£] key to confirm.
Your piece is now saved in a file whose title appears to the
right-hand side of the menu bar.
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The following illustration shows the rest of the song "Happy
Birthday to You". Complete it in the same way you entered the
first section.

File (0 Edit (B Playback SD Display

01 02030405060 BDOSDO TO OCVOHH ®

" Va"

From now on, you will be able to enter melodies with an
accompaniment, to play them back and to modify them as you
wish. When you open another file. Visual Composer will close
this one. However, you will be able to go back to it any time
you like. Keep it on hand for those special birthdays.



f
 f
 f
 f
 f
 
C 

C 
f
 
C (
 f
 f
 
f 
f
 f
 (
 f
 (
 f
 f
 
t
 
C 
f
 f
 
C 
f
 I
 f
 (
 f
 (
 (
 f
 
f
 f
 f
 
C f

 (
 C
 I
 f
 f
 
c



References

Contents
(wrns

Keyboard Commands 85

Function Keys 85

Arrow Keys 86

Quick-Move Commands 87

Voice Activation Commands 89

Other Keyboard Commands 90

Menu Commands 91

The File Menu 91

New 92

Open... 92

Save 93

Save As... 94

Revert 94

Music File Directory... 94

instrument File Directory... 95

Quit 95

iMis



References

Contents

The Edit Menu 96

Cut 96

Copy 96

Paste 97

Clear 97

Semitone Up 97

Semitone Down 97

Octave Up 98

Octave Down 98

The Playback Menu 98

Play 98

Play Voice 98

Interrupt 99

Basic Tempo... 99

The Display Menu 100

Tempo 101
/m^

Instrument 101

Volume 102

Pitch Accuracy 102

Large Grid 103

Medium Grid 103

Fine Grid 103

Ticks per Beat... 103

Beats per Measure... 104



References

Contents

The Options Menu 104 ^
With Percussion 104 ^
Without Percussion 105

Audio Feedback 105

MIDI Input... 105 ^

The Help Menu 106



References

Keyboard Commands

This section systematically describes all of Visual Composer's
commands. It is divided into two parts: the first covers all
keyboard commands; the second describes the different menu

^  commands.

Keyboard Commands

Function Keys

ED Activates the Write Mode and highlights the pen symbol
in the upper left-hand corner of the screen.

\  (ID Activates the Select Mode and highlights the selector
^  symbol in the upper left-hand corner of the screen.

liO Activates the Interpretation Data Mode and highlights
the active interpretation category, in the upper left-hand
corner of the screen.

Displays a list of all the instruments in the linked
instrument directory. The instrument list is only available

^  if instrument interpretation data is chosen, if one voice is
lit up, and if an edit field is opened.

(iO opens the File menu.
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Keyboard Commands

HD Opens the Edit menu.

(ZD Opens the Playback menu.

(fU Opens the Display menu.

(ZD Opens the Options menu.

friol Opens the Help menu.

Arrow Keys

NOTE: in this section, the + sign means that the foiiowing key must
be pressed while the preceding one is held down.

13 or 13 Moves the cursor to the left or to the right.

Moves from one menu to another, once a menu is open.

13 + Q or
13+13

In Write Mode (13). moves the pen cursor so that it
"writes" notes. When used over a written note, the note
is erased.

1#^

In Select Mode (HD), moves the cursor, creating a
highlighted zone in the grid. The notes of the active
voice covered by this highlighted zone make up the
selection. It is this selection which will be affected by the
Edit and Playback menu. (m9\
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Keyboard Commands

or Q Moves an indicator within the following lists:

•  command menus ((10 to (^)
•  file list (Open..., (iD)
•  instrument list (IKI)

In Write Mode ((ZD), moves the pen up or down.

Quick-Move Commands

(ctrT) + (3 or

(cjO + (3 Moves the cursor to the following or proceeding beat
line.

(±] or Q Moves the cursor to the following or preceeding bar line.

(^ +13 or
13+13 Writes a note or extends a selection to the following or

preceeding bar line.

13 + IM) + 13 or
3 + EiiD + Q Writes a note or extends a selection to the next beat line.

[Homei Places the cursor at the left-hand edge of the grid. If the
cursor is already there, the lH»tne| key scrolls the
composition one grid width to the left.

IE"" 1 Places the cursor at the right-hand edge of the grid.
If the cursor is already there, the Ie"" i key scrolls the
composition one grid width to the right.

+ iHomej Extends a selection to the left-hand edge of the grid.
If the selector is already there, the 3 and iHomti
keys extend the selection one grid width to the left.
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+ (iiin Extends a selection to the right-hand edge of the grid. If
the cursor is already there, the + l^"" 1 combination
extends the selection one grid width to the right.

+ iHomel Places the cursor at the very beginning of the
composition.

+ (iiiri Places the cursor at the very end of the composition.

■
f [Ctrl 1 + iHomel Extends a selection to the very beginning of the

composition.

(3 ■f ̂  + (iin Extends a selection to the very end of the composition.

lpgl^ Moves the pen one octave up, in Write Mode.

iPgPnl Moves the pen one octave down, in Write Mode.

+ |pgUp| Scrolls the composition and the grid one octave up.

+ iPgPftl Scrolls the composition and the grid one octave down.

m Places the pen on an A.

dJ Places the pen on a B.

(□ Places the pen on a C.

m Places the pen on a D.

(D Places the pen on an E.

o Places the pen on an F.

El Places the pen on a G.

88



Z
References

Keyboard Commands

Eltodj When a file list or an instrument list is displayed, or when
a menu is opened , the alphabetic keys will select the
first word that starts with the letter which corresponds to
the key pressed.

Voice Activation Commands

/«\

+ Q to CD Activate the melodic voices corresponding to the
f. ^.,y

numbers on these keys.

,«, The following five key sequences correspond to the
/•*> percussion instrument voices:

@+ C3 Bass Drum (BD)
@+ CD Snare Drum (SD)

+ CD Tom-Tom (TO)
@+ CD Cymbals (GY)
@+ CZ] Hi-Hat (HH)

If you have decided to make use of 3 additional melodic
voices instead of percussion voices, keys (D. Q and
CD. when pressed with the key, activate the
melodic voices corresponding to the numbers on these
keys (see the command Without Percussion of the

/SP^

Options menu).

/*pp^ + (D Activates all voices, making it possible to apply the Edit

/PPS^

commands to all voices at the same time.

NOTE: Since a specific voice has to be chosen before writing, Visual
Composer will not let you write if aii voices are active.
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Other Keyboard Commands

Q (Return) Confirms a choice or an instruction:
•  in menus (([D to (riol);
•  in dialog boxes.

in Interpretation Data Mode (ED), opens and closes the
edit field where the cursor is positioned.

Closes a menu or a dialog box, cancelling the operation.

In Write Mode (ED), moves the cursor back one tick,
shortening the note to the immediate left of the pen. This
key only effects notes in the active voice.

In Interpretation Data Mode (ED), clears the open edit
field.

I  I (Space bar) In Select Mode (ED), undoes the active selection
without moving the cursor.

EID (Escape)

(Backspace)

(mm,
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Menu Commands

The menu bar displays the titles of the different command
menus provided by Visual Composer: File, Edit, Playback,
Display, Options and Help.

To open any of these menus, all you have to do is press the
function key displayed to the left of each menu name. You can
close a menu by using the (iicl key.

/•-i\
The File Menu

@Fjle
'  1

Neu) BE9 N
Open... SEg 0
Saue mil S

Saue fls... BEg fl

Music File Directory,
Instrument File Directory... 1

Quit

IS Edit IB Playback QD Display 03 Options 00 Help untitled

fim,

The File menu contains all the commands relating to files.
To open this menu, press the (iD key.
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Menu Commands

New

This command enables you to open a new file (empty and
untitled). When you choose the command New, the opened
file displayed on the screen is closed to make room for the new
empty one; Visual Composer takes the precaution, however, of
first asking you if you wish to save the latest changes made.

Open...

This command is used to open a file from the linked music file
directory. When you choose this command, a dialog box
appears on the screen listing all the Visual Composer files in
this directory.

Edif (S Playback 6D Display

®l 02 03 04 05 06 OBD

cpianol

Options

0 SD 0 TO 0 CV 01

Music File Directory:

c;\ro1]demo

alhambra \m Select File;
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Menu Commands

To choose a file from this list, press the vertical arrow keys (Q
or O). These keys will also scroll the file in the dialog box if
the list of names is too long. When the indicator highlights the
desired file, press the ED key to confirm.

You can also press the alphabetical key corresponding to the
first letter of the file name: the indicator will move directly to the
first file name starting with this letter. If there is more than one
name which starts with the same letter, press the arrow key to
continue.

When you choose the command Open, the opened file
displayed on the screen is closed to make room for the new
one. Visual Composer takes the precaution, however, of first
asking you if you wish to save the latest changes made.

Save

This command saves the opened file in the current directory. If
this file has already been named, it will automatically be saved.
If, however, it is a new file, a dialog box will appear, so that you
can name it.

NOTE: Refer to the following paragraph (Save As...) for the rules
which apply to naming files.
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Save As...

This command is used to save the opened file under a new
name.

When naming a file, you must keep in mind the following rules:

•  The name must have from 1 to 8 characters.
These characters are to be chosen from the capital and
small letters of the alphabet and from the digits 0 to 9.
You can combine letters and numbers.

If the name you choose has already been used for an existing
file in the current directory, a dialog box asks if you wish to
overwrite the old one, replacing it with the new.

Revert

This command cancels the modifications made to a file. It
reverts the file back to what it was the last time you saved.

When you ask Visual Composer to revert a file, it will always
ask for a confirmation of this command.

Music File Directory...

This command links the program to a new music file directory.
This makes it possible to open files in a different directory than
the one to which the program was first linked. Enter the name
of the desired directory into the dialog box which appears,
abiding by the DOS conventions. Finally, press the E) key to
confirm your instructions. From now on, the command Open
will display the list of files in this new directory. The name of
the current file always appears in the upper right-hand corner
of the screen.
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Instrument File Directory...

This command links the program to a new instrument file
directory. This makes it possible to use sounds in a different
directory than the one to which the program was first linked.
Enter the name of the desired directory in the dialog box which
appears, abiding by the DOS conventions. Finally, press the
Q key to confirm. From now on, the instrument list shown by
the command will display the list of instruments in this new
directory.

Quit

This command is used to end a Visual Composer session and
to return to DOS. Before this command is carried out, a dialog
box appears to ask if you wish to save the changes you have
made, if there were any.
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The Edit Menu

(a File GBEdit

Copy
Cut

Paste

Gear

IB Playback SO Display QD Options HQ Help untitled

QB C
BQIK
BEIU

Semitone Up
Semitone Domn

Octaue Up
Octaue Dotun

(DQU
lilil D

The Edit menu lists the commands which perform operations on
a selected section of a piece. To open this menu, press the (iE)
key. If nothing has been selected on the grid, the displayed
commands will appear dimmed, that is to say, unavailable.

Cut

The command Cut deletes the selected section from the
composition and puts it in the selection buffer where it replaces
anything that might already have been there. The notes to the
right of the selection are automatically moved so that they fill
the gap created.

NOTE: Interpretation data is not included in this operation.

Copy
The command Copy copies the selected section and puts it into
the selection buffer where it replaces anything that might have
been there already.

NOTE: Interpretation data is not included in this operation.
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Paste

The command Paste inserts a copy of the selection buffer's
contents at the point where the cursor is positioned in the
opened file, if something on the screen has been selected, the
selected items are replaced by a copy of the selection buffer's
contents.

NOTE: If the commands Cut or Copy are carried out with the "All"
voice indicator highlighted, the command Paste also has to
be carried out with this indicator highlighted. By the same
token, if only one voice is active during a Cut or Copy
operation, then only one can be active when it is time to use
the command Paste.

Clear

This command deletes the selected section from an opened
file. Unlike the command Cut, the command Clear does not put
the selected group into the selection buffer. Also, the notes to
the right of the selection stay in place, creating a gap where the
deleted selection used to be.

Semitone Up

This command transposes the selected section a semitone up.

Semitone Down

This command transposes the selected section a semitone
down.
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Octave Up

This command transposes the selected section one octave up.

Octave Down

This command transposes the selected section one octave
down.

The Playback Menu

Play 0Q31P
Play Uoice QQIV

IS File (S Edit 63 Display IS Options SQ Heto untitled

Play
Play Uoice
Internet

Basic Tempo... QBEB T

The Playback menu contains all the commands which involve
playing back the pieces written using Visual Composer. To
open this menu, press the (ZD key.

Play

This command lets you listen to the composition in the opened
file. When a section of the piece is selected, you will only hear
that section played.

Play Voice

This command lets you listen to the active voice of the
composition in the opened file. When a section of the piece is
selected, you will only hear the active voice of that section
played.
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Interrupt

This command is used to interrupt the playback of a song. At
the beginning of the playback, a clock symbol momentarily
appears on the screen (in the menu bar). For as iong as you
see this clock, the command Interrupt and, for that matter, all
commands will be inoperative.

Basic Tempo...

This command is used to check or aiter the basic tempo of a
composition. When it is chosen, a dialog box appears
displaying the tempo of the current composition. You can alter
this tempo by entering a new number corresponding to the
number of desired beats per minute.

NOTE: Tempo changes entered as interpretation data are indicated
in the form of multipliers applied to the basic tempo.
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The Display Menu

IS File IS Edit (S Playback |F8|ijg^
Tempo

03 Options QQ Help untitled

/ Instrument
Uolume

Pitch Accuracy

Large Grid
1/ Medium Grid
Small Grid

Ticks po' Beat...
Beats per Measure...

To open this menu, press the (iD key.

The first four commands determine which interpretation data
category is to be displayed; the rest of the commands in this
menu determine the size and the divisions of the grid.

When you choose an interpretation data category, Visual
Composer displays your choice in a box to the left of the
interpretation data bar, and shows the data pertaining to this
category.

/m0\

/mms

(mms
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Menu Commands

To enter new interpretation data (changes in tempo, volume,
instruments or pitch accuracy), activate the Interpretation Data
Mode by pressing the key, and place the cursor at the
desired position. Next, press the Q key. This opens an edit
field in the form of a black rectangle in which you can enter the
desired change. Press the Q key once more to close this edit
field. The key enables you to clear an edit field.

Tempo

When you choose this command. Visual Composer displays
"Tempo" at the left of the interpretation data bar and shows any
tempo changes in this bar.

In this context, the number 1.0 means 100% of the basic tempo,
the number 1.5 means an increase to 150% and the number 0.5

means a decrease to 50% of the basic tempo. The extreme
numeric values allowed are 0.01 and 10.0.

NOTE: Tempo changes apply to all voices.

Instrument

When you choose this command. Visual Composer displays
"Instr." at the left of the interpretation data bar and shows, in the
bar, any instrument changes for the active voice.
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There are two ways of entering the name of an Instrument in an
opened edit field: by writing it in directly or by calling it up from
a list of available instruments in the active directory. This list is
displayed by pressing the (ED key. To choose an instrument,
either use one of the vertical arrow keys (Q, O) or the key
corresponding to the instrument's first letter (which will
highlight the first instrument name starting with this letter). If
there is more than one name that starts with the same letter,
press the arrow key to continue. Confirm your choice using the
r»n key. Visual Composer places the name of the desired
instrument into the open edit field.

Volume

When you choose this command. Visual Composer enters
"Vol." at the left of the interpretation data bar and shows any
changes to the volume of the active voice.

In this context, the number 1.0 means 100% of the maximum
volume established by the external volume control of the Ad
Lib Music Synthesizer Card. All intermediate values are
permitted, creating dynamics from one extreme to the other.
The default volume setting for all voices is 0.75.

Pitch Accuracy

When you choose this command. Visual Composer enters
"Pitch" at the left of the interpretation data bar and shows, in the
bar, any changes in the pitch of the active voice.
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The values entered here correspond to a pitch deviation of an
accurate sound. The deviation scale includes values from 0.0
to 2.0. The number 1.0 represents the accurate sound; the
number 0.0 takes the sound one semitone down; the number
2.0 moves the sound one semitone up. Intermediate values
are permitted, making it possible to create effects from one
extreme to another. Generally speaking, a deviation of about
0.1 between two voices in unison is sufficient to create rich
effects.

Large Grid

The command Large Grid gives you large-size notes and a
two-and-a-half octave piano keyboard. Use this grid to
examine your manuscript as if through a magnifying glass.

Medium Grid

The command Medium Grid gives you medium-size notes and
a four octave piano keyboard. This is the most frequently used
grid - which is why it is pre-selected.

Fine Grid

The command Fine Grid gives you small-size notes and a six
octave piano keyboard. It helps you see more notes at once.

Ticks per Beat...

This command is used to determine the smallest beat fraction
within a given piece. Although a beat is initially divided into
four parts, you can divide it into as many as 99 parts.
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Enter a number in the dialog box which appears on the screen
and press the (3 key. The number of ticks per beat
determines the spacing of the dotted vertical lines separating
the beats.

Beats per Measure...

Use this command to determine the number of beats in each
measure. Visual Composer is preset at four beats per
measure. You can change this, however, to as many as 99
beats per measure.

Enter a number in the dialog box which appears on the screen
and press the E] key. The number of beats per measure
determines the spacing of the solid vertical lines separating the
measures.

The Options Menu

(3 File 03 Edit (9 Playback 63 Display 03 Options 66 Help untrtled
v/ IDith Percussion

Ulithout Percussion

/ Audio Feedback

MiDHnpot illM

With Percussion

This command gives you 6 melodic voices and 5 percussion
voices as opposed to the 9 melodic voices possible with the
following option.
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Without Percussion

This command gives you 9 melodic voices as opposed to the 6
melodic voices and 5 percussion voices possible with the
preceding option.

NOTE: When going from the one option to the other, Visual
Composer warns that instrument changes made in voices
found in only one of the two options will be lost.

Audio Feedback

The command Audio Feedback lets you hear notes as they are
being written. This command is activated and de-activated
alternately by choosing it.

MIDI Input...

This command becomes accessible when Visual Composer
detects the presence of a MIDI driver. When you choose this
command, a dialog box appears on the screen asking you to
press a key when ready to start entering notes. From then on,
you may use a MIDI keyboard to enter notes into Visual
Composer. (See appendix D for more details.)
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The Help Menu

(SFfle IS Edit IB Playback laDisplaj) G3 Options 00 Help untitled

introduction

The Grid

Mouonent

Notes
Selection

Uoices

Interpretation Data

The Help menu gives you access to a summarized program
guide.

When you press the (rwj key, the list of information categories
seen above appears on the screen.

When you choose one of these categories, a window
containing pertinent information opens. The arrows located at
the bottom of this window indicate which keys are used to see
the other pages of this document. To dose this window, press
the (113 key.
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i; [a File (B Edit ffl Playback BP Displajj Bj} Options

M III (i> I 0 B 0 3 0 4 0 5 0 6 0 BP 0 SD 0 TO 0 CV 0
llnstr, fpiano I

Dotted uertical lines are used to separate beats.
By using the command Ticks per Beat in the Display menu, you
may select the number of ticks in each beat.
The command Basic Tempo in the Playback menu controls the
number of beats per minute,

(S Cancel
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Appendix A
List of Preset Sounds

BANJ01

BASS1

BASS2

BASSOON1

BDRUM1

BELLS

BRASS1

CLAR1

Banjo: excellent for short notes in quick succession: sounds
best from one octave lower to three octaves higher than
middle 0.

Double bass: weak volume; inaudible when notes are very
low. Best register: the two octaves below middle 0.

Electric bass: smooth; best when used in second and third
octaves below middle 0.

Bassoon: sounds an octave lower than written. Best register:
from one and a third octaves below to two octaves above

middle C.

Bass drum: hammering; sounds best in the second octave
below middle C.

Chiming bells: brilliant and resonant; sound best between the
first octave below to the three octaves above middle 0.

Brass ensemble: "brassy"; sounds best from two octaves
below to two octaves above middle 0.

Clarinet: best when used one octave below and two to three

octaves above middle C.
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List of Preset Sounds

CROMORNE Cromorne: wind instrument used in Renaissance Period; very
accentuated reedy sound. Best register: from one octave
below to two octaves above middle C.

CYMBAL1 Cymbal: medium-crash (high pitched), played with drumstick.

ELGUIT1 Electric rock guitar: distorted (fuzz pedal effect). Best register:
from one octave below to two octaves above middle 0.

ELGUIT2 Electric jazz guitar: soft; slightly metallic; sounds best from
two octaves below to three octaves above middle 0.

FLUTE Flute: soft sound; sounds best in the four octaves above
middle 0.

FLUTE1 Flute: soft muffled sound; sounds best in the four octaves
above middle 0.

FLUTE2 Flute: like flute sound on an electric organ; sounds best in the
four octaves above middle 0.

HARPSI 2 Harpsichord: full accentuated sound; sounds best from two
octaves below to two octaves above middle 0.

HARPSI 3 Harpsichord: appropriate timbre for low register; sounds best
in the three octaves below middle C.

HIHAT1 Hi-Hat: closed double cymbals played with drumstick;
metallic resonant sound.
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MARIMBA1 Marimba: wooden bars played with medium-hard mallets;
sounds best from one octave below to four octaves above

middle C.

MARIMBA2 Marimba: wooden bars played with hard mallets; resonant
and slightly metallic. Best register: same as Marimba!.

0B0E1 Oboe: sounds best in the two and a half octaves above
middle C.

0RGAN1 Electric organ: bright sound; sounds best from one and a half
octaves below to three octaves above middle C.

0RGAN2 Electric organ: velvety; sounds best from two octaves below
to two octaves above middle C.

PIAN01 Piano: sounds best from three octaves below to four octaves

above middle C.

PIAN02 Resonant piano: pedal effect; sustained; same register as
Piand. (Everything played lower than the first octave below
middle C sounds like a resonant electric bass.)

SAX1 Saxophone: sounds best from two octaves below to two
octaves above middle C.

SITAR1 Indian Sitar: rich and resonant; sounds best from one octave
below to two and a half octaves above middle C.

SNARE1 Snare drum: snappy; high pitched.

SYN1 Synthesizer: slow attack; sonorous. Best register: the three
octaves either side of middle C.
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List of Preset Sounds

SYN2

SYN3

SYN4

SYN5

SYNBASS1

TINCAN1

T0M1

TR0MB1

TR0MB2

TRUMPET1

TRUMPET2

Synthesizer: short, staccato, artificial sound of plucked
strings; sounds best from two octaves below to four octaves
above middle C.

Synthesizer: resonant; short attack. Best register: from three
octaves below to four octaves above middle C. (When used
in the second and third octaves below middle C, a rich and
powerful bass sound is produced.)

Synthesizer: twangy brass sound; sounds best in the two
octaves below and four octaves above middle C.

Synthesizer: very piercing sound; lots of high harmonics.
Best register: from two octaves below to two octaves above
middle C.

Synthesizer: buzzing distorted bass; sounds an octave lower
than written. Best register: the two octaves below middle C.
(Also interesting above middie C.)

Percussion effect: dry, metallic sounds, varying from note to
note; indeterminate pitch; use above middle C.

Tom-Tom: smooth; sounds best the third octave and half of
the fourth octave below middle C.

Trombone: "brassy"; sounds best when used from the two
octaves below to one octave above middle C.

Trombone: velvety; same register as Trombi.

Trumpet: very sonorous (striking); sounds best from one
octave below to three octaves above middle C.

Trumpet: soft; slow attack (wah-wah mute effect); same
register as Trumpet!.
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TRUMPETS Trumpet: very resonant; twangy; excellent for quick passages;
same register as Trumpetl.

TRUMPET4 Trumpet: smooth; same register as Trumpetl.

TUBA1 Tuba: with characteristic slow attack; sounds best when used
in the two and a half octaves below middle C.

VIBRA1 Vibraphone: metal bars played with medium mallets; vibrato;
sounds an octave lower than written. Best register: four
octaves above middle C.

VI0LIN1 Violin: strings played with bow; rich sound; best when used in
the four octaves above middle C.

VI0LIN2 Electric violin: noisy sonority, with light vibrato; same register
as Violinl.

VLNPIZZ1 Violin: strings played pizzicato (very short plucked sound);
volume weak. Best register: from one octave below to three
octaves above middle C.

XYL01 Xylophone: narrow wooden bars played with medium
mallets; sound very dry and dampened. Best register: the
second, third and fourth octaves above middle C.
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Technical Data

^  Sound Driver
/««^ —

/Wi

^  The sound driver enables Visual Composer to be used with the
^  Ad Lib Music Synthesizer Card. When you ask Visual

Composer to playback a piece, the program stores the data
needed to perform this operation into a memory buffer. The
size of this buffer determines the reaction time of the program:
the bigger the buffer, the more information the program can
store in advance and the quicker it can respond to your
commands.

However, the memory used for the buffer cannot be used for
anything else - be it another piece or another program.
Therefore, adjust the size of the memory buffer according to

^  your needs.

Adjusting the Size of the Memory Buffer

When the commands contained in the file COMPOSER.BAT

are carried out, the sound driver of the Ad Lib Music
Synthesizer Card is loaded before the Visual Composer
program.

^  To change the size of the memory buffer, you must modify one
of the lines in the COMPOSER.BAT file by supplying a different

^  value (argument) to the sound driver's loading program.
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1. Open the file COMPOSER.BAT with a program
editor.

2. Find the line containing the word "sound".

On this line, you will find the letter "b" followed by a
hexadecimal number. This parameter indicates the present
size of the buffer.

Example: sound btOOO

3. Replace the present size by the desired size, using the
table seen below as a guide.

4. Save the COMPOSER.BAT file.

To put the adjustment into effect, it is necessary to reset the
computer; for it is when the program is loaded that the sound
driver notes the configuration of the memory.

Buffer Size Program
Argument

4K blOOO
6K b1800
8K b2000
10K b2800

12K bSOOO

It is worthless to increase the dimensions of the memory buffer
beyond 12K.
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Technical Data

Memory

Visual Composer adjusts itself to the amount of memory
available in your computer. A driver allocates parts of the
memory for the operations being carried out. When an
operation is completed, the driver frees the space used by this
operation.

This memory management method makes it possible to get the
most out of a limited amount of memory. It can, however, break
the memory up into very small fragments that cannot be
reused. This may happen if there is not much memory
available or if the music is particularly complex. Visual
Composer might then interrupt a session.

When this happens, the open file is closed and the music it
contains is automatically saved under the name RESCUE.ROL
Visual Composer then returns to DOS. To find the piece you
just lost, all you have to do is reload Visual Composer and
open the file named RESCUE.ROL. You can then give this fiie
back its original name by using the command Save As.
Reloading Visual Composer solves most memory problems.
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Error Messages

Cannot write when ail voices are activated.

The pen cannot write when ail the voices are active.
Activate one voice and try again.

Directory "xxx" not found.
There is no directory corresponding to this name. Make
sure that the name conforms with the DOS conventions.

Disk drive is not ready, re-insert diskette, close
door and try again.
The program cannot gain access to the disk drive. Make
sure that the diskette is properly inserted into the disk
drive and that the door is closed.

Diskette is write-protected, remove protection
and try again.
No information can be added to the diskette because it

is write-protected.

Error while reading or writing, diskette may be
unusable.

The program cannot gain access to the contents of the
diskette. By using the DOS COPY command, copy the
contents of the diskette onto a blank diskette and try
again.
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•  Error while writing file, insufficient disk space.
There isn't enough space on the diskette to write the
data. This message could also appear if the maximal
number of files on a diskette is reached.

•  File "xxx" is incompatibie with program version.
The Visual Composer that you are using cannot open
this file, because it was created by another version of
Visual Composer.

File "xxx" not found.

The program cannot find the specified file. This is
probably because the music file diskette was removed
after the command Open had been executed. To
correct, re-insert the correct diskette.

•  Instrument list unavailable when edit field

unopened.
The instrument list is only available if instrument
interpretation data is chosen, if one voice is lit up, and if
an edit field is opened.

•  Instrument "xxx" not found.

The program cannot find the specified instrument file,
because a bad name was given, an improper music
directoiy was specified or the diskette was changed.
In the first case, check if the correct name was typed.
In the second case, change the instrument file directory
(consult Menu commands). In the last case, re-insert
the correct diskette.
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Insufficient memory to continue.
The program lacks memory space. Your file is either too
large, or the memory Is too fragmented. Fragmentation
occurs when a large number of operations are
performed with a limited memory space. Reload the
program and try again. The work in progress may be
found under the title RESCUE.ROL.

Insufficient memory to open fiie "xxx".
The program cannot load the specified file, because the
space required is greater than the space available. To
correct, quit the program and change the size of the
sound driver (see Appendix B) or delete other resident
drivers from memory.

internal error: operation canceiied.
An unexpected error occured. Please report the
problem to our Customer Service, relating all details and
circumstances under which it occurred.

Last copy or cut pasted to incorrect number of
voices.

When the selection buffer contains data from one voice,
the data cannot be pasted to all voices. Similarly, data
from all voices cannot be pasted to one voice.

Resource fiie not found.
The program cannot function because the file
C0MP0S1.RSR is not in the active directory.
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Error Messages

Sound driver buffer too small to play this piece.
The memory buffer of the sound driver is too small for all
the sound Information of this piece. Consult "The Sound
Driver" section of Appendix B to see how to adjust the
buffer dimensions.

Sound driver Is not Installed.
The program cannot function because the sound driver
has not been loaded. Load the sound driver and try
again. This should not happen If you use
COMPOSER.BAT- the normal loading procedure.

Unable to create temporary backup file,
Insufficient disk space.
Some extra space was required to save the file, but the
diskette was full. To save, change the music file
directory to another diskette.
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Using a MIDI Interface

If your computer is equipped with a Roland DG MIDI
Processing Unit MPU-401, or any compatible, you may use a
MIDI keyboard to enter notes into Visual Composer. Simply
load the MIDI driver provided on the diskette into the memory
by writing the following command at the DOS prompt:

A>mpu401

When Visual Composer detects the presence of a MIDI driver,
the command MIDI Input becomes accessible in the Options
menu. When you choose this command, a dialog box appears
on the screen, featuring the following message:

"Press OK to enter MIDI data into selection memory."

Press the Q key to notify the program that you are ready to
enter notes. From then on, you will hear a metronome and you
may play on your keyboard the notes you wish to enter.

To stop recording, press any key on the computer keyboard.
The entered notes are placed into the selection buffer. You
may then put them anywhere in the piece by using the
command Paste of the Edit menu.

NOTE: Visual Composer accepts MIDI recording, one voice at a time.
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Using a MIDI Interface

Apart from the position of the notes on the keyboard, only the
times at which the keys are struck and released are recorded
into memory. Therefore, any other data (after-touch, velocity,
pitch bend, etc.) is ignored.

The accuracy of the recording is relative to the tempo and to
the number of ticks per beat. The program rounds off any note
length in the execution to the nearest tick per beat. A very
accurate reproduction of what was played is possible if a large
number of ticks per beat is chosen.
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Appendix E
Using a Mouse

This appendix explains how to use Visual Composer with a
mouse - which we take for granted you know how to operate.

Loading Visuai Composer with a Mouse Driver

Visual Composer automatically detects and utilizes a mouse
driver If one Is loaded. Load your mouse driver according to
the manual that comes with the mouse. Next, load Visual
Composer In the usual way. The program Is compatible with
mouses by Microsoft (and all related drivers) and Mouse
Systems PC Mouse.

NOTE: You may integrate the loading of the mouse driver with the
AUTOEXEC.BAT fiie.
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When the mouse driver Is already installed but you don't wish
to use it, load the program with the option 7-m". This option
prevents the automatic utilization of the mouse driver. At the
DOS prompt, type:

A>COMPOSER /-M

Program Particularities When Using a Mouse

Choosing an element in a list
Choosing a mode or a voice
Scrolling
Writing notes
Entering interpretation data
Selecting
Piano keyboard

p^

Choosing an element In a list

A command in a menu

Position the pointer on the title of the desired menu.
Click and drag to the chosen command, then release the
mouse button.

A file in a list
Click on the name of your choice, then release the
mouse button. If the list of files is too long for the
window, click on the arrow in the scroll bar to scroll the
list.

(Wm)
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Using a Mouse

Choosing a mode or a voice

To choose from either the Write Mode or Select Mode of
operation, click the appropriate symbol in the upper left-hand
corner of the screen.

To activate the Interpretation Data Mode, simply click at the
desired place in the interpretation data bar.

To choose a voice, click one of the voice symbols which will
then light up.

Scrolling

The scroll bars placed along the writing grid let you see the
contents of a file. You may scroll vertically and horizontally.

These are the different ways to scroll:

Scroll progressively
Click the arrow pointing in the direction you wish to
scroll.

•  Scroll sectionally
Click the grey zone of the scroll bar.

•  Scroll to any part of the document
Click and drag the scroll cursor to a point corresponding
to the passage of music you wish to see.
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Writing notes

When you choose the Write Mode, the pointer on the screen
becomes a "pen". From then on, the actions of the mouse are
the actions of the pen.

♦  To write notes
Point to the grid where you wish to begin the note. Click
and drag the mouse.

•  To write notes free-hand
Pressing the (3 key, click and drag the mouse. You
may thus create free melody lines.

Entering interpretation data

Before entering interpretation data, choose the desired data
category in the Display menu and the desired voice in the
voice indicator bar, and simply open an edit field.

To open an edit field
Click on the interpretation data bar where you wish to
enter data. A black rectangle - the edit field - will
immediately appear, indicating that you may enter the
desired data.

•  To close an edit field
Click anywhere outside the edit field. It will close
automatically.
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^  Selecting

By choosing the Select Mode, a selector appears on the grid.

To select a group of notes

-  Click and drag the selector over the section of music
concerned.

To quickly select large sections of music

1. Place the selector at either end of the section to be
selected.

2. Point to the other end. It may be necessary first to
scroll the music.

3. To end, press the key and click.

To extend or shorten a selection

•  Position the selector where you want the extended or
shortened selection to end.

•  Pressing the (3 key, click or drag to complete the
selection.

Piano keyboard

To play any note on the piano keyboard situated at the left of
the screen, point the arrow on the key you wish and click.
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